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Updates 

Release Notes 

This document contains notes about the NeXT™ Software Release 2.0. The first section 
provides late-breaking information or other points of interest about the 2.0 software. The 
last section briefly describes some key differences between this release and Software 
Release 1.0. 

Recovering Disk Space 

November 1990 

Recovery tips: If you have a lOS-megabyte hard disk drive installed in your NeXT 
computer and find that you need more disk space, try the following to recover some 
space. (Be sure to use the Empty Recycler command in the File menu to destroy any 
files you drag into the recycler.) 

1. Review your personal files (including mail messages) and delete as many of them 
as you can. (Use the Compact command in Mail's Utilities menu to destroy deleted 
messages.) 

2. Look over the demo applications in INextDeveloper/Demos and delete any that 
you're not interested in. (You cannot, however, delete the INextDeveloper/Demos 
folder.) 

3. If you need even more disk space, you can gain 3 megabytes of space by deleting 
the thesaurus used by Digital Webster™; specifically, delete the folder 
INextLibrary/References/Webster-Thesaurus. If you absolutely need more 
space, you can gain an additional 15 megabytes by deleting the dictionary, 
INextLibrary/References/Webster-Dictionary. (Consider backing up these files 
so you can restore them in case you have more space available in the future.) 
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Workspace Manager and File System 

Copy and move: When you drag an icon to another folder, whether it's copied or 
moved depends on both the location and ownership of the source and destination 
folders. If you drag to a folder on the same disk and you're the owner of both the source 
and destination folders, Workspace Manage/M moves the file or folder; otherwise, it 
copies the file or folder. 

Open as Folder: The first time you open a folder in a separate window, it appears in 
the same type of view as the window you opened it from (rather than always opening 
in icon view, as stated in the documentation). 

Folders in INextDeveloper: The INextDeveloper folder contains an Apps folder and 
an Examples folder only in the extended release of the software. 

Guided Tour demo: On the extended release, the INextDeveloper/Demos folder 
contains an application named Guided Tour.app that will help new users get a feel for 
what it's like to work on a NeXT computer. 

Ejecting disks: To eject disks, be sure to choose the Eject command from the Disk 
menu. Do not press the eject disk button on the device unless you're prompted to by 
the system. 

Working with MS-DOS Disks 

Printing 

Release Notes 

Initializing disks: After initializing an MS-DOS disk to a UNIX® disk, you must log 
out. 

Copying files to MS-DOS disks: If you try to copy more information to an MS-DOS 
disk than it has free space, Workspace Manager brings up a window that asks you to 
Stop or Proceed. Do not click Proceed because you may lose data on your hard disk. 
Clicking Stop will abort the operation and prevent data loss. 

Manual paper feed: When you click Print in the Print panel after choosing Manual, a 
panel containing Stop and Continue buttons appears if no paper has been manually fed 
after a short while. Click Stop if you want to halt printing and cancel the print request. 
The panel will go away when you begin feeding the paper or when you click Continue. 
You have a total of three minutes to begin feeding paper after you click Print; after three 
minutes, paper will be fed from the paper cassette. 
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Preferences 

Large File System: The Expert Preference called Large File System speeds up the 
display of folders that contain large numbers of files and folders (possibly at the 
expense of slowing down scrolling through the folder). Contrary to the documentation, 
folders continue to be differentiated from files in a browser, with an arrowhead symbol 
as usual. 

WriteNow 

Quotes in Merge template: In an instruction in a template document read by the 
Merge command, nonnumeric values must be enclosed in quotes-for example, «IF 
city="Middletown"». (The quotation mark must be ", not" or ".) 

Dictionary preferences: The Dictionary field in the Preferences panel initially shows 
WNDictionary.wndict. WriteNow® will look for a default dictionary by that name in 
your home folder; if there's none there, the dictionary by that name that's supplied in 
WriteNow's file package will be used. To specify a different dictionary in your home 
folder, you need only enter its file name (or other pathname relative to your home 
folder) and click Set. You can return to the initial default of WNDictionary.wndict by 
clearing the field and clicking Set. 

MS-DOS disks: Don't save files onto MS-DOS disks from WriteNow. Instead, edit and 
save WriteNow files on the hard disk. To do this, use Workspace Manager to copy 
WriteNow files onto the hard disk before editing them and to copy them back to the 
MS-DOS disk when you're done. 

Digital Library 

November 1990 

Folder icons: Some folders in INextLibrary are represented by icons that depict what 
they contain, rather than the standard folder icon. 

Librarian Services command: A Librarian Services command has been added to the 
Info menu in Digital Librarian TM. This command lets you control the services Librarian 
provides in other applications. You can enable or disable the Search and Target 
commands in the Librarian submenu of the Services menu, and you can create custom 
Search commands that specify a particular target. Use Librarian's Help command to get 
more information (enter Librarian Services as your query). 

Multiple target: You can drag a mUltiple selection (the icon of a hand holding several 
cards) into the target area; however, don't attempt to index such a target. 

Indexing: If the folder name for a target has any spaces in it, the target won't be indexed 
properly. (It's OK for a target's label in the target area to have spaces in it, however.) 
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Mail 

Faxes 

Initial mail retrieval: When Mail starts up, it may take a while for your new messages 
to show up in your mailbox (depending on the volume of mail). 

• Sort order: After you undelete messages or compact a mailbox, the messages will 
appear sorted by number regardless of the previous sort order. 

Lip Service recording: When you're recording with the Lip Service™ panel, clicking 
Play doesn't stop the recording as documented (you must click Stop). 

Lip Service attachments: Lip Service attachments can't be cut, copied, and pasted like 
other attachments. To move an incorrectly placed Lip Service attachment, delete it and 
then insert it again in the correct location from the Lip Service panel. 

Spell checking availability: Contrary to the documentation, the Spelling command 
isn't limited to use in a Send window; it can also be used in the message area of a 
mailbox window (the search for misspelled words starts at the beginning of the 
message). The same is true for Check Spelling, with the added feature that it can also 
be used to check spelling in text fields in panels. 

No Receipt and NeXT Mail: The No Receipt and NeXT Mail buttons in the Send 
window indicate the mode in which Mail will send the message; their labels change to 
indicate a different mode when you click them. To get a notification when the message 
has been read, click No Receipt to change it to Receipt; to send the message to a 
non-NeXT computer, click NeXT Mail to change it to Non-NeXT. 

Mail Services: If you have an RTF file open in the Edit application and you choose 
Selection from the Mail submenu of the Services menu, the selection appears with the 
proper fonts and formatting in a Send window, but the triangle symbol doesn't appear 
on the Deliver button. When you mail the message to another NeXT computer, the fonts 
and formatting are removed. 

• FaxReader icon: If there are no received faxes, the FaxReader icon in the dock should 
show no paper coming out of the fax machine. However, this works only if you've set 
Fax Reader to start up automatically when you enter the workspace, and then only until 
you unhide it; at other times, the paper is shown in the icon regardless of whether there 
are received faxes. 

Tall images: If a received fax contains an image that's taller than the paper you print 
on, you can only print the top portion of the image. Only as much of the image that fits 
on one page is shown. This is most frequently encountered when there's a caller ID line 
at the top of a letter-size fax. 
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Fax modem port: In the Choose Fax Modem panel that appears when you click the 
Modem button in the Fax panel, the port a fax modem is attached to should be indicated 
by the letter A or B in the Port column if the fax modem is connected to your computer. 
This feature doesn't work: The Port column is always blank. 

Margins in custom cover sheet: Margins in Cover. rtf are relative to the width of the 
text in the Cover Sheet panel. Make sure that if you change Cover.rtf, you make your 
margins smaller. 

Mass Storage 

New disk drive: A 200 MB Hard Disk has been added to NeXT's product line. The 
specifications for this internal storage device are as follows: 

3.5-inch half-height form factor 
200 MB formatted capacity 
15 ms average seek rate 
4.0 MB/sec maximum transfer rate (synchronous) 
Software Release 2.0 preinstalled on disk 

Upgrade2.0 

November 1990 

Disk space: If you're upgrading a computer with an existing hard disk, Upgrade2.0 will 
need at least 5 MB and possibly as much as 20 MB of free space on the hard disk. If 
you keep around the Release 1.0 version of Mathematica® or Allegro CL ® Common 
Lisp, it will need 7 MB or 8 MB more, respectively. In Release 1.0, you can use the 
Disk Info command in Workspace Manager's Files menu for disk space information. 

IfUpgrade2.0 estimates that there's not enough room on the hard disk to perform the 
upgrade, it displays a message to this effect in its window when you start up the 
application. Before you can perform the upgrade, you must make more room by 
deleting files from the disk. (If you click the Upgrade button anyway, a similar message 
appears in a panel; click Cancel to remove the panel.) 

1. Return to Workspace Manager (click in the File Viewer or double-click the NeXT 
icon in the dock; don't quit Upgrade2.0). 

2. Delete files from /UPGRADE2.0 (which contains the entire contents of the hard 
disk). 

3. Return to Upgrade2.0, quit and restart it, and see whether there's enough disk 
space; if not, repeat these steps until there is sufficient space. 
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It may happen that Upgrade2.0 needs more room than it originally estimates. In this 
case, it will present an attention panel during the upgrade that says the disk is full. To 
continue with the upgrade, follow steps 1 and 2 above, dragging the panel off to the side 
if necessary (if you've elected to replace a large number of modified files, you may find 
that IUPGRADE2.0!UPGRADEDFILES is a good place to begin looking for files to 
delete). Then return to Upgrade2.0 and click Proceed in the panel. It' s very important 
that the upgrade be continued in this manner or your hard disk may be lefi in an 
inconsistent state. 

Continuing an interrupted upgrade: If a power failure or other unexpected problem 
interrupts an upgrade, you'll need to restart Upgrade2.0 so that the upgrade can be 
completed. Upgrade2.0 can automatically resume the upgrade at the point where the 
problem occurred. Answer any questions the same way you answered them the first 
time. 

FrameMaker 

Update FrameMaker 2.0b: FrameMaker® 2.0b uses a font encoding mechanism that's 
incompatible with NeXT's Release 2.0. To fix your copy of FrameMaker so that it will work 
with 2.0, follow the steps below. (Do this even if you're only upgrading some of your 
systems to 2.0.) 

1. U sing Workspace Manager, find the folder where FrameMaker.app is installed. 
Normally, it's either in ILocalApps or your own personal Apps folder, -/Apps. (This 
update doesn't apply to the Release 1.0 demo version of FrameMaker in 
IN extDeveloper/Demos.) 

2. If you installed FrameMaker in your own -I Apps folder, skip to step 3. If FrameMaker 
was installed in a shared folder owned by root, you must log in as root to go any further 
(your system administrator may need to help you with this). 

3. Use Workspace Manager to find INextAdmin/FrameUpdate.pkg and double-click it. 
This will start up the Installer application. 

4. In the Installer application, click the Install button. In the panel that appears, select the 
folder where FrameMaker is installed (which you found in step 1), and click OK. 

5. Installer will ask you to confirm where you would like to install this update. An alert 
panel will tell you that some of the files in this package are already installed, and that 
continuing will overwrite these files. Click Continue to complete the installation. 

Two things that can go wrong with the installation are: 

Release Notes 

You don't have permission to write the files that need changing. You can solve this 
problem by logging in as root on the computer containing the disk that FrameMaker 
resides on. 
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• You installed the update in the wrong folder. If you specify a folder other than the one 
in which FrameMaker is installed, you'll end up with a file named FrameMaker.app 
that's incomplete and doesn't have the FrameMaker icon. This happens because the 
update is not a complete FrameMaker release; it needs to be installed on top of your 
existing FrameMaker 2.0b. 

Network and System Administration 

Novemher 1990 

System administration bookshelf: In INextLibrary/Bookshelves in the extended 
release of the software, there's a bookshelf named SysAdmin.bshlf, which has the 
Network and System Administration manual and the UNIX manual pages as its targets. 

Using BuildDisk on very large disks: If you use BuildDisk to install the system 
software on a NeXT 660 MB hard disk, your system may not be able to boot normally. 
(The disk comes built, so building the disk again is usually unnecessary.) To fix the 
problem, edit letc/fstab before you reboot. Delete the line that begins with "/dev/sdOb". 
If you try to reboot before deleting this line, the boot process will end with the 
presentation of a small window with an error message followed by a "#" prompt. You 
can continue the boot by typing Control-D at that prompt. When booting completes, be 
sure to edit letc/fstab so that booting will proceed normally in the future. 

The NeXT 660 MB hard disk (and some disks from other vendors) has no entries in the 
file letc/disktab. Ifthe your disk has no entry in letc/disktab, BuildDisk will correctly 
format the disk to have one partition, but will set up the letc/fstab file as though the disk 
has two partitions. This will cause booting to end prematurely. (Note that BuildDisk, in 
this case, will not ask how many partitions you want to create.) 

Serial ports: For an update to information about serial ports, look in the NeXT User 
target in Digital Librarian; this update supersedes the information in the zs manual page 
in the Network and System Administration manual appendix. 

NetManager: When you choose Save To Domain in NetManager, and the host you're 
saving already exists in the specified domain, NetManager asks you if you want to 
overwrite the existing entry. However, NetManager doesn't overwrite the entry even if 
you ask it to. Rather, it adds another entry with the same name. You should manually 
delete the old one by opening it and choosing Delete from the Host menu. Be sure 
you've opened the old entry by examining any fields you changed. 

Network time service: The discussion of network time service implies that if you try 
to change the time on a time client, it will eventually resynchronize with the network 
time. This isn't true if you change the time with the date command. If you do change 
the time with the date command (which is not recommended), you must resynchronize 
the time either by clicking the Synchronize button in the Date and Time panel in the 
Preferences application, or by executing the command 

/usr/etc/ntpd -F 
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• InstallTablet: If you're using a SummaSketch tablet and switch tablet modes, you must 
reboot after switching modes. 

Setting Up 

Power cord: A 125V parallel-blade UL-listed power cord is provided by NeXT; for 
240V power, a 250V tandem-blade UL-listed power cord should be used. 

Key Differences from Release 1.0 
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This section summarizes significant differences from the Release 1.0 software. For details, 
see the user manuals. 

General 

• Menus and commands: Many application menus have been reorganized, and some 
keyboard alternatives have changed, to comply with the new NeXT user interface 
guidelines. 

• Folders: Directories are now referred to as "folders." 

Workspace Manager 

Release Notes 

Customizing your dock: When you start up the computer after updating to Release 
2.0, your application dock may not look the same as it did in 1.0; if it doesn't, just 
customize it yourself as necessary. If you specified applications to start up 
automatically in 1.0, you must reset them with the Preferences command in the Info 
menu. 

File Viewer window: The Directory Browser window has been replaced by the File 
Viewer window, which is divided into three areas: a shelf at the top for displaying icons 
of files and folders that you access frequently; below that, an icon path showing the path 
to the current selection; and an area at the bottom of the window for viewing the 
contents of folders. 

Browser and other views: The folder view area is initially a browser, similar to the one 
in the 1.0 Directory Browser window; you can change this view with commands in the 
View menu. Icon view is similar to Icon view in 1.0, except that double-clicking a 
folder icon opens that folder in the same window, rather than in another folder window. 
Listing view provides the same information as Name view in 1.0. To display the 
contents of a folder by date or size, choose the Inspector command from the Tools menu 
to display a panel in which you can choose a sort option. 

4. , 
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Icon path: The icon on the far right in the icon path indicates the selected file or folder, 
and is thus equivalent to the icon in the icon well in 1.0. Clicking a folder icon in the 
icon path selects the folder; this is the primary way to move up the file hierarchy. To 
scroll along the highlighted branch of the file hierarchy, use the scroller at the bottom 
of the icon path. In browser view, the icon path shows the selection in each column of 
the browser. 

Shelf: You can click an icon on the shelf to select it. To open a file from the shelf, 
double-click it. Add icons to the shelf by dragging them there from the icon path (or 
from icon view). You can remove any icon from the shelf, except the home folder icon, 
by dragging it out into the workspace. 

Copy and move: Copying or moving files and folders has been simplified. Select what 
you want to copy or move, then drag your selection's icon from the icon path onto the 
shelf. Next, display the destination folder in the icon path and drag the selection from 
the shelf into the destination folder's icon (possibly holding down a modifier key; see 
below). As in 1.0, the cursor's shape changes to indicate whether you're copying or 
moving. You can force a copy with the Alternate key, and force a move with the 
Command key. 

Background processes: Workspace Manager now performs file operations in the 
background, allowing you to continue to work while files are being moved or copied. 
You can track background processes with the Processes command in the Tools menu; 
this can be very important if you're performing an operation that may take some time 
and that must be completed before you perform another operation (for example, if 
you're moving a large number of files out of a folder that you then want to rename or 
delete). If a background process encounters an exceptional condition-for example, a 
full disk-the Processes panel will appear describing the condition and providing 
options for completing the operation. 

Typing pathnames: To open a file or folder by typing its pathname, choose Finder 
from the Tools menu. 

Recycler: The black hole icon has been replaced by the recycler icon. Deleting with the 
recycler works the same way as with the black hole. Unlike the black hole icon, the 
recycler icon cannot be moved out of the dock, and it remains in the dock when you 
double-click it to display its contents. When there's somethingCin'the recycler, a sphere 
appears in the center of the icon. 

Disk commands: The Disk menu replaces the Optical menu. The Mount and Unmount 
commands are no longer available; disks are automatically mounted when inserted in a 
drive, and automatically unmounted when ejected. Optical disks (or floppy disks) 
appear in your root folder rather than in your home folder. 

Killing an application: You can now kill an application by choosing Processes from 
the Tools menu and clicking the KiII button that appears in the Processes panel when 
the Applications option is selected. 

Information about files: To get information about files or folders that was previously 
provided by the More Info command, use the Inspector command in the Tools menu . 

• 
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Digital Librarian 

Reindexing: You must rebuild the indexes for any targets that you indexed in Release 
1.0. (Digital Librarian in Release 2.0 will consider targets with old indexes to be 
unindexed.) 

Preferences 

Setting the time: If your computer is on a network and its internal clock is managed 
by your system administrator, you'll no longer be able to set the time. You may only 
synchronize the time on your machine with the network time, though you can still 
change the time zone. 

Keyboard diagram: In Keyboard Preferences, in the Keyboard panel, the diagram of 
the keyboard is not accurate for older keyboards. For more information, see the Notes 
in Appendix E of the N eXT User's Reference manual. 

PrintManager 

Local_Printer: There must always be one and only one printer entry for the local 
NeXT 400 dpi Laser Printer. PrintManager no longer lets you delete or add entries for 
the local NeXT printer. 

Current printer: The current printer is no longer marked with a check mark in the 
PrintManager window; it's the one that's highlighted in the window when you first start 
up PrintManager. 

WriteNow 

Mail 

10 Release Notes 

Checking Document Format: There's a slight difference in the way lines are spaced. 
As a result, when you open old documents you'll get the "Checking Document 
Format..." panel. If you subsequently save the document, it will open the next time 
without the "Checking Document Format..." panel. To avoid this problem, you should 
open and save all the documents that you use. 

New Mail command: The New Mail command now beeps if there's no new mail. If 
there is new mail, the command will seem to execute immediately (rather than wait 
until all t~e new mail has been retrieved). It's actually retrieving the new mail in the 
background; the mail will show up a little later. 
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Terminal 

November 1990 

New application: A new Terminal application is available in INextApps; this 2.0 
version of Terminal combines the functionality of the 1.0 Terminal and Shell 
applications, and provides full VT100 terminal emulation. For information about this 
application, see the NeXT Development Tools manual in the NeXT Developer's Library. 
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